SCIA

ENGINEER

TUTORIAL
CABLES



Tutorial — Cables

All information in this document is subject to modification without prior notice. No part of this manual may be
reproduced, stored in a database or retrieval system or published, in any form or in any way, electronically,
mechanically, by print, photo print, microfilm or any other means without prior written permission from the
publisher. SCIA is not responsible for any direct or indirect damage because of imperfections in the
documentation and/or the software.

© Copyright 2021 SCIA nv. All rights reserved.

2 BV —2021/11/19



Table of Contents |

TADIE OF CONTENTS ..oiiiiiii ittt s e Rt e s e e bt e st e e e n et e san e e sare e e nnneesareeennneen 3
LT Ao Te 1U 1 4] ] o TSP PUR PR 4
Chapter 1: I aY=Te] =T A Toz= I o = Tod Xqo 01U [ o P PPRERR 5
Chapter 2: 1771 T 1= 1 1 o ST 6

P2 TR O g 13T =T £ - S TP PRRP 7

27 € 1= Y o 1= 1 7

2.3, BoUNAAry CONAITIONS ..oiiiiiiiiiiiiiie ettt e et e e s b e e e 10
Chapter 3: Loads and COMBINAtIONS ... 13
Chapter 4: AANBIY SIS ettt et e b e e e e e e e aanee 15
Chapter 5: RESUILS ettt e ek e e e ek e e e et e e e e et e e e et e e e ab e e 16

BV —2021/11/19 3



Tutorial — Cables

Introduction

SCIA Engineer allows you to model a structure with cables.

First, we will discuss the theoretical background.
Next, we will explain how to model and load a chandelier structure.

Finally, we will run the (nonlinear) analysis and evaluate some results.

The figure below shows the model of the structure that we will design.
Y
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Chapter 1: Theoretical background

Since SCIA Engineer version 21.1, cables are fully supported in the 64bit version in the default post-
processing environment. For cable analysis the module sens.03 is necessary. This module is included in the
Expert and Ultimate edition.

A cable element is an element without bending stiffness (ly and 1z 00). During the solving of the equations
this behavior is taken into account, so only axial forces (in tension only) will occur and you will obtain zero
values for the internal forces Mx, My, Mz, Vy and V. The displacements (in the intermediate nodes) have thus
been calculated without bending stiffness.

The cable type is a special type of a beam nonlinearity, which can be applied on 1D members in a model.

You will need to create nonlinear combinations to take into account this nonlinear property during the
analysis. A geometrical nonlinear analysis should be executed by calculating with a 3 order analysis with
the Newton-Raphson calculation method.

A curve formed by a hanging cable is called a "Catenary". With relatively small bending (height - sag roughly
10% of its length) the curve can be approximated by a parabola (this approach was implemented previously
in the 32bit version of SCIA Engineer in the post-processing environment ‘v16 and older’), but such
approximation however becomes imprecise with greater sag / length ratio (and for different heights of the begin
and end nodes of the cable).

The catenary curve is linearly approximated into a polyline. The approximation points (nodes) are calculated
from the catenary equation defined by two edge points of the beam and its parameter a, which is defined as a
quotient (normal force / cable weight per unit length). The normal force is defined via the nonlinearity
parameters and the cable weight per unit length is calculated from the cross-section and material parameters.
Formula of the general catenary equation:

x—k
y=a-cosh( 2 )+c

Parameters k and c¢ represent the horizontal and vertical shifts of the curve, respectively.

The relation between catenary length s, vertical span of two definition points v and their horizontal span H is:

H
s2 —vy2 = 2-a-sinh<—)
2a
You have full control of the catenary curve approximation precision. A general curvature approach has been
utilized. Using the curvature (parameter defining how much the curve bends at the given point) the radius of
the circles (of the same curvature as the curve in the touching point) is calculated. Concept of the
approximation error is graphically described in the figure below:

The detailed background (including formula to calculate the value of sag) can be found on our help-pages:
https://help.scia.net/webhelplatest/en/#analysis/nonlinear_analysis/cables/cable.htm
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Chapter 2: Modelling

In the Project settings dialog, activate the Concrete and Steel material.

Project data

Basic data Functionality Actions UnitSet Protection
| DATA
MName: -I

Part: -
Description: -
Author: -

Datet -

Structure: & General XYZ

| Post processing .
snvirenment # default

Model: ﬁ One

| MATERIAL

Concrete

Material €25/30

Reinforcement m B 500B
Steel

Material $235

Masonry
Aluminium
Timber

Steel fibre concre

i CODE
Mational Code:
[ R
v Mational annex:

[ [l

Ok

W

¥ o

L

Cancel

On the Functionality tab activate the Cables functionality:

Project data

Basic data Functionality Actions UnitSet Protection
| GENERAL
Property modifiers
Model modifiers
Parametric input
Climatic loads
Mokile loads
Dynamics
Stability
Nonlinearity u
Structural model
IFC properties
Prestressing
Eridge design
Excel checks

DETAILED

4  Nonlinearity

Beam local nonlinearity
Support nenlinearity/basic soil s

Initial imperfections
Geometrical nonlinearity
General plasticity

Compression-only 20 members

| Cables ﬂ_l

Friction support/Soil spring
Membrane elements
4 Subsoil
Soil interactien
Pad foundation check
4 Steel
Plastic hinge analysis

Fire resistance checks

Ok

Cancel

Note that for cable analysis the module sens.03 is necessary. This module is included in the Expert and

Ultimate edition.

When the Cables functionality is turned on, automatically the functionality Geometrical nonlinearity is

turned on as well.
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2.1. Cross-sections
Go to Menu bar > Libraries > Cross sections (or with the icon in the workstation Structure).

Add a rectangular concrete cross-section of 400 x 300 mm for the circular ring at the bottom of the
chandelier. Add a circular shape or polygon of diameter 30 mm for the cable elements.

B Cross-Sections x>
H iR EE «2 O @l A 2 |
51 - Rectangle (40.. Mame €51 A

52 - Polygon (30, 8) Type Rectangle

Detailed 400; 300
Shape type Thick-walled
« Parameters
Material C25/30
H [mm] 400
B [mm] 300
« General

Nz ~elaoe Normal coloor W

]

Mew Insert Edit Delete Setup | Update all | Close

2.2. Geometry

You can open the Marking menu by holding the Alt button together with the right mouse click. In the
subgroup Model you can choose to add a 1D member:

I
A ®

A
1D Member @ ‘\
RS

8 &
MODEL

Draw the ring as two circular arcs with cross-section CS1.
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Tutorial — Cables

Then you can use the Marking menu again to add 8 Column elements with cross-section CS2 and length 12

m.

Then select the top nodes of the column elements. Change the X and Y coordinate of these nodes to 0 m via
the property panel or via the input table (Tools > Input table):

= INPUT TABLE

4 Name
N9
. N1l
Ni2
. Ni4
N15
N1T
N18
N20

LR T T R B ™ R

R swwre ~ [l | 8 EEIEGEE IR

X [m] ¥ [m] Z[m] Member 2D me...

0.000 5.000 12.000 | B11
-3.536 3.536 12.000 . B12
-5.000 0.000 12.000 . B13
-3.536 -3.536 12.000 . Bl4
0.000 -5.000 12.000 | B15
3.536 -3.536 12.000 . Bl6
5.000 0.000 12.000 . BIT
3.536 3.536 12.000 . Bls

ot | @2 4T B K

Run the Check structure command to eliminate the duplicate nodes at the top:

Check of structure data
CHECK OF NODES
v
Search duplicate nodes Ignore parameters
v
CHECK OF MEMBERS
B Checkm| Result of check of nodes
Search null L
These oroblems have been found with nodes:
Search dul
Members with undefined nodes: 0 J
Free nodes 0 ! L
Dublicate nodes: 7 B Correctit
CHECK OFD
Nodes not in slab: 0 I
Checkd : ' -
Incorrect coord. 0
CHECK OFA Do vou want to correct it?
Check a% 0%
OK Cancel
Check frl L i
1)
0%
Check load panels Check cross-links
Check additional data Check duplicity of names
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Now we have already following structure:
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Tutorial — Cables

2.3. Boundary conditions

You can use the marking menu to quickly add a fixed support at the top.

Now you can apply the Nonlinearity 1D property to the elements. You can search for it via the SCIA Spotlight

or find it via Input panel > workstation Structure > category Boundary conditions.

TutorialCablesStart

o aar =
I L Nonlinearity 10 02. I
=7 Structure.Modeldata.Sectiononbeam

Non-prestressed reinforcement

ﬁf_ Nonlinear combinations
M Nonlinear functions
u;; Define Result classes. A Result classi...

H Toggle nonlinearity

Following parameters are available for the type cable:

INPUT PANEL
Structure v~
Boundary conditions

All tags

QLB i

yo’ﬁunmmwm@ 4 41 @« b %

7

}40- 0 00

B ' Beam nonlinearity

Normal force [kN] 1.00

Approximation error [m] 0.010
Maximum sag [m] 0.000

Direction of load £ i

Name BMN1
T}rpe Cable A

Self weight @ YES
Pn [ki/m] ©.00

OK Cancel

* Normal force [kN]:
*  Self-weight:

e Pn[kN/m]:

» Direction of load:

value of the pre-stressing axial force (positive)

determines, whether the cable is subjected to self-weight

specifies the value of the additional load (so other than self-weight)
specifies the load direction (Pn and self-weight)

» Approximation error [m]:determines the maximal allowed distance between point on the analytically
defined catenary curve and the projection of this point (in the direction of
load) on the linearly approximated polyline of the cable.

e Maximum sag [m]

automatically calculated value, it is the maximal distance (in the direction of

load) between a node of the catenary curve and its projection on the straight
line connecting both ends of the cable

Set 1 kN as normal force, activate self-weight and set 0 kN/m as Pn.

10

BV —2021/11/19



When applying the nonlinearity to the elements automatically the geometry is deformed according to the
catenary curve which is calculated with the inputted parameters.

Add an element with cross-section CS1 in the middle of two vertical elements.

Via the subgroup Modify of the Marking menu you can select the Multicopy command and copy the
horizontal element 8 times.

Multicopy X
Number of copies & 2
Insert the very last copy Copy additional data
DISTANCE VECTOR HOW TO DEFINE THE DISTANCE ?
Define distance by cursor ® between two copies
x 0.000 m from original to the last copy
HOW TO DEFINE THE ROTATION ?
v 0.000
® between two copies
£ g:000 from original to the last copy
ROTATION ROTATION AROUND
. 0.00 deg ® current UCS
& 0.00 o distance vector
45|
e | deg 0K Cancel

Connect the new elements with the existing vertical elements. When you now would change the
nonlinearities (e.g. change the value of the normal force), it will have an effect on the elements with the
nonlinearity, but as well on the connected elements.

C rworstcattesstar
ELinect members/nodes| 0 X

|'||- Connect members/nodes ’

||:p Disconnect members/nodes

[EF Restore default user configuration

1= Define the load case. A load case ... Ctrl+L

v

Select all the new elements via the Expand selection function in the Property panel and add the Cable
nonlinearity as well to the elements.

1D MEMBER (1) A

- WITRN

g I

Name B12

Layer Layerl —

Type beam (80)
Analysis model  Standard
FEM type standard ~~
Cross-section €S2 - Polveon (30,8) =—

i Isolate selection

 Expand selection

Subtract from selection
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Go to the load cases and create a new load case LC2:

B Load cases ¢
iR a0 @B A vY]
LC1 - Self WEIght Name LC2
Lc2 Description
Action type Permanent v
Load group LG1 e
Load type Standard v
Stage for composite a Final stage, long term v
Actions
Delete all loads >>>
Copy all loads to another loadcase  >>>
New Insert Edit Delete Close

Via the subgroup Load of the Marking menu you can select the Point Load in Node command and add some
point loads of 1 kN to the structure:

B Pointforce in node X
Mame m
F Direction Z il
Rx Type Force -
";.4. : Angle [deg]
' : Value- F[kN] -1.00
4 Geometry
System GCS »
6 ©
Fy
v d

oK. || cancel
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Tutorial — Cables

Open the nonlinear combinations:

m @ I NONLINEAR COMBINATIONS

CIODGCIERR

7

9% 5

LN

And create a nonlinear combination NC1 with load cases LC1 and LC2:

# Nonlinear combinations X
- iEZFE «2 O A vy
NC1 Name NC1
Description
Type Ultimate v
Stage for composite analysis m Automatic v
4 Contents of combination
LC1 - Self weight [-] 1.000
LC2 [] 1.000
New from combinati..., New Insert | Edit Delete Close

14
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Chapter 4: Analysis |

As the calculation model is completely ready, you now can start the calculation.

Use the Calculate button in the middle of the process wheel in the process toolbar to start the analysis (or
via Menu bar > Tools > Calculation & Mesh > Calculate).

. l A\C_
| CALCULATE

JQCIEES
A »

«
[

=

When starting the analysis, check that for the Mesh setup the Average number of 1D mesh elements on

straight 1D members (linear approximation between the nodes of the catenary curve) and in the Advanced

solver settings Geometrical nonlinearity is set to 3" order (large deformations). If there are problems

with convergence, increase the values of Number of increments, or Maximum iterations. Additionally, the

Solver precision ratio or Solver robustness ratio might be altered to have an influence on the

convergence criteria as well. Select Nonlinear analysis and press Calculate.
B FE analysis

~
Calculations 4 _Mesh setup

IAverage number of 1D mesh element: 4 I

Linear analysis

Average size of 1D mesh element on ¢ 0.200
Load cases: 2

# Nonli tvad Average size of 2D mesh element [m] 1.000
) Nonlinear analysis

Nonlinear combinations: 1 Connect members/nodes
Setup for connection of structural ent

Other processes
P Advanced mesh settings

Test input of data 4 Solver setup

Specify load cases for linear calculati
SO Specify combinations for nonlinear c:
4 Advanced solver settings
P General
P Effective width of plate ribs

4 Nonlinearity

Geometrical nonlinearity 3rd order (large deformation) v
Method of calculation Newton-Raphson v

Number of increments 5

Maximum iterations 20
Solver precision ratio 1
Solver robustness ratio 1
4 Initial stress

Calculate Initial stress
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Tutorial — Cables

Chapter 5: Results

When the calculation is completed, results can be viewed. The relevant commands in the workstation
Results become active now.

Select the workstation Results in the process toolbar and click on the command 3D deformations.
‘J‘,‘i' .Z;D DEFORMATIONS

BWma twes o0 8
o

With the 3D deformations you can evaluate the behavior of the cables for the nonlinear combination NC1
and you will see that the cables go upwards. The graphical results look a bit strange because SCIA Engineer
presents the biggest deformation as 1 m:

i

¥

10

This makes sense for general structures, but for cables it's more convenient to look at the real ratio, which
can be edited via the Scale settings in the View bar. Set Scale type to Real ratio and Deformation [1:x] to
1.

oo DL m 0w e|D] | m
| Scaleadddata 1 .._
*~—

I -__.—: Scale settings I

Scaleresultdata 1

B Scales x

B E as mE A .Y

Current Name Current fal

4 Data
Scale type Automatic ratio v
Multiplier 1
4 Loads
Point loads [kN] 1.000
Line loads [kN/m] 1.500
Surface loads [kN/ 2.000
Temperature [K] 10-00
Translation [m] ©0.010
Masses [kg] 1000.00
User defined AddDa 1
4 Result

| Scale type Realratio =
Multiplier 1
Reaction [kN] 5.000
| beformation 17 1 ]

Internal forces [kN] 5.000
Stress [MPa] 20.0

Contact stress [MPa] 20.0

Unity check results 1
Other results 10

4 Summbale
New Insert Edit Close
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B sca Engineer - a »

# SCIA 21 1006 Tutorialcablestnd |1
DB Mm@ ool l & ERR AR ey OGN = Cme D BEE
4 3p displacement ) = 31 INPUT PANEL
Values: Utotal E | & Al workstations
Nonlinear calculation = L=
NonLinear Combi: HCL ms 'y | [ B Alcegories
Selection: Al 200 @ §
Location: In nodes avg. on macro. mo | & mises
System: LCS mesh element
00 GHCGa S
1800 = =
Pty =i TNvOw
=09 avYersesdolw
1m0
100.0 = B & -~
80.0 - T - R
o e
08 | RESULTS (1) 2]
20 -
- | Name 3D displacement
w SELECTION
(8 Typeof selection  All
I Fiter No v
~ RESULT CASE
I’* Typeofload NonLinear Combinations.
(% Nonlinear Combi NC1
s Wirelrame ()
a Location  In nodes avg. on macro
Value U_total
System  LCS mesh element
) Exreme 10 Global
4 Extreme 20 Global v
0T | ¥ CALCULATE RESULTS ON ..
e 1D members @)
g 2D positiveface (@2
Iy a M negtvetace @D
& g v DEFORMED STRUCTURE
* Deformed structure @9
= for global maximum
1 e ~

# @Refr%h
E}is A EE T e & ol O B I e ﬁ“} SZZI"LTI:”"
T

o o |

You can notice that the load straightens the curved elements.

You can also have a look at the 1D internal forces such as normal forces N or bending moments My. Select
the workstation Results in the process toolbar and click on the command 1D internal forces.

| 1D INTERNAL FORCES

BN Aol | | e o

For these results you can put the Scale type back to Automatic ratio in the Scale settings.

Normal forces N:
]

= a X
@, 211002364 TutorialCablesEnd H
DB X @@ © o fa [ o bype yourtert..lewi th lines below ev AN 2 D mm
}‘ 1D internal forces INPUT PANEL
Values: N

|2 All workstations
Nonlinear calculation L=

NonLinear Combi: NCL
Coordinate system: Principal

L= Al categories

Extreme 10: Global | @lasss
Selection: All
Slecen G HEO A S
) 2 e
M= e
W avedesdolBe
—
“}_ﬁ R
) 0 T o
N /,— | RESULTS (1) 2]
| é/— | Name 10 internal forces
B VA— L
iy ~ SELECTION
- . Typeof selection  All
" Fiter No v
Resultsinsections  All /
b < ResuTcAsE
n Typeofload NonLinear Combinations.
3 Nonlinear Combi  NC1
| v EXTREME 10
= | Extreme1D Global
Values N v
£ ntenal - (3
’ Coorinate system  Principal
' [~ DRAWING SETUP 10
e Display valuename (3 )
= Display values @9
T visplayunics @D
v Displaycase (3D
: Display sectiondkx (I
= Display combinationkey ()
18 Display combination name (3 )
» achons S et
a0 e @ et
B}]‘E @ A WG ft o7 “‘3 @ Fesultstable
CR N
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Tutorial — Cables

Bending moments My:
B scakng

S,zum

- 8 %

D& X wm@ o o fa

4 1D internal forces
Values: My
Nonlinear calculation
NonLinear Combi: NC1
Coordinate system: Principal
Extreme 1D: Global
Selection: All

WMET W D FFT

Al
o

B

L8
M
BN @@ 7w
CR B

Please click here o press Speice and type your text... it will be completed with lines belo

L2y

AW = 2| @@
INPUT PANEL
& All workstations
B All categories
@ Altgs v
G HEOB S
K= > = ]
AavesTesdolwe
= B & -~
(&)
RESULTS (1) 2
Name 10 internal forces [
~ SELECTION
Type of selection  All v/
Fiter No
Resuls i sections  All v/
~ RESULT CASE
Typeofload NenLinear Combinations.~
Nonkinear Combi  NCL v
~ EXTREME 1D
Extreme 1D Global
Values M_y v/
Interval ()
Coordinatesystem  rincipal
~ DRAWING SETUP 1D
Displayvaluename (3
Display values @)
Display units  (@Y)
pisplayease (3D
Display sectiondx (3
Display combinationkey (3
Display combination name (3

ACTIONS 3>

@® Fefresh

@ FResuts table

@ Preview

So in the cables, the only non-zero values of internal forces are for the normal forces N (tension). On the

second picture we can see that there are no bending forces present in the cables

Notes:

« The input of the cable element only defines the initial shape / sag. Afterwards the cable can be
loaded by real loads. The normal force after calculation will therefore be different to the inputted

initial normal force N.

» Adding a cable into the model will adapt the mesh also for the linear calculations. This means that
the linear calculation may become unstable when a cable is added, and a nonlinear calculation

becomes necessary to obtain results.

18

BV —2021/11/19



